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Chapter 1 - Introduction to the
program

Introduction to the program

HAPPIE (Hazard of Aquifer Pollution Potential Impact Evaluation) allows the best evaluation of the area and
entity of potential pollution caused by a discharge into an aquifer.

The development of this program was inspired by H. Le Grand ("A standardised system for evaluating a waste-
disposal site", N.W.W.A, Worthington 1983), including the modifications necessary to connect the concepts of
distance between the discharge site and water well, direction and hydraulic gradient expressed in the mentioned
publication with the need to produce geometrically plausible “areas of risk”.

In his publication H. Le Grand has proposed a method that evaluates the risk of pollution of only one water well
from a single discharge. The HAPPIE program considers the impact of a discharge on a territory in which
various water wells have been distributed.

Le Grand’s “standardised system” enables the use of some easily determined parameters and the subdivision of
each of these into a group of discrete classes. A point system is used to assign a value to each one of these
classes: by summing these values one obtains a number that increases as the safety of the discharge does,
and diminishes as the hazard increases.

The HAPPIE program calculates the area covered by different zones of influence. Danger classes and distance
are the calculation parameters. The problems of using functions to perform step inversions and the possibility
that under particular conditions ranges will result geometrically insignificant have been resolved with algorithms
than promote safety.

Since the method of Le Grand does not offer a continuous variation of the influence of underground flow
direction, but considers two conditions “favourable” and “unfavourable” (water well upstream or downstream of
the discharge respectively), the graphical representation of each area, characterised by a certain risk factor,
shows it to be formed by two adjoining semi-circles of different diameters. It is therefore assumed that in the
zone downstream of the discharge, the area characterised by a certain class of risk, is presented as semi-
circular (with a range equal to the maximum distance possible to re-enter in the indicated class if the flow
direction is “unfavourable”), while in the zone upstream is presented as a semi-ellipse cut along the major axis
(equal to the diameter of the “unfavourable” zone) and minor semi-axis equal to the maximum distance relative
to the zone uphill of the discharge (range of the zone defined “favourable”).

The program requires some easily determined parameters.

— Piezometric Depth

The presence of a superficial water table allows a rapid diffusion of the liquid pollutant, a phenomenon that
is weakened by the absorbing and filtering of the drained layer of terrain above the phreatic surface. The
water table must be considered as placed at the highest level among those measured or assumed, as it is
more easily reached by the pollutant. The depth of the water table must be expressed in meters from the
ground level plane.

— Lithologic Characteristics of the Porous Medium

The different materials have different filtering capacities and permeability values that cause variations in the
degree of absorption and liquid pollutant diffusion underground.

— Hydraulic Grade

Since the velocity of a fluid in a porous medium is proportionate to the hydraulic grade, as it increases so
does the distance that the liquid pollutant can reach without being significantly diluted. The larger the grade,
the more difference there is between the impact of the discharge on the water wells situated up and downdhill
respectively. The grade is expressed as a percentage, that is, in meters of height for each one-hundred
meters of planimetric distance.

— Flow Direction

Distances being equal, there can be a big difference between the polluting effect made on a water well
uphill of a discharge and on one that is downhill from it. The flow direction is expressed in degrees
clockwise starting from North; for example, the four cardinal points are directed: N=0, E=90, S=180, W=270.
To take into account evaluation errors of the direction and the possibility that it may vary naturally, if a
discharge is at high risk, the flow direction becomes insignificant and the dangerous areas become circular.
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Rainfall

The volume of liquid pollutant produced by the discharge and therefore the potential pollution depends on
the rainfall. The rainfall value must therefore be the highest value registered. Rainfall is expressed in
millimetres of annual precipitation.

Average temperature

This is necessary as a correction factor of the rainfall for evapotranspiration. It is expressed as the average
annual temperature in degrees centigrade.

Degree of Discharge Hazard

Discharges can be subdivided into two categories depending on the type of material discharged: Discharges
at high risk, and discharges at medium risk. For those at medium risk two cases relative to the thickness of
the underlying permeable layer are to be considered: indefinite or limited by an impermeable bed.

Thickness of the Superficial Medium

If the discharge is at medium risk on a layer obeying Darcy’s law, limited by an impermeable bed it is
important to know the thickness of the superficial permeable medium. The thickness is expressed in meters.
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Chapter 2 - System requirements
and program installation

System requirements

e Pentium® class processor

e Microsoft® Windows® 95 OSR 2.0, Windows 98, Windows Me, Windows NT®* 4.0 with Service Pack 5 or
6, Windows 2000, or Windows XP

e 64 MB of RAM (128 MB recommended)
¢ 100 MB of available hard-disk space
e CD-ROM drive

e A printer driver must be installed, even if the printer itself is not connected to the PC.

Program Installation

To install HAPPIE run the happie32setup.exe installation package from the CD-ROM or from the download
directory.

Winip Self-Extractor - happie32setup.exe |

@ Prezs SETUP ta start installation

Cancel

About

Il

Press the Setup button...

HAFPF/IESZ Setup

Choose the installation directory:

ey

[ My Documents
B Program Files
CIWINDDWS

Do you have an hardware protection key?

@ Mo, l am running a demo version.
@ Yes, | have a parallel key.
@ Yes. | have a USB key.

[l Restore the default configuration of columns. logo and textures.

o |
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...and select the directory to create the HAPPIE32 folder.
Click the Continue button and the program program is automatically installed.

The first time you run the program the window that allows you to select your preferred language appears.
Simply click on the flag of the language you prefer.

Select your language. ..
BN BN =5

The language selection will be saved in the “LANGUAGE.CFG” file, which is found in the program directory. To
select another language, it is sufficient to exit the program and delete this file. The language selection window is
shown once more at the next run of the program.
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Chapter 3 - The program
protection

Hardware protection key

This section should instead be carefully read if the program was bought through the Internet.

Hardware protection key - Parallel port

Plug the hardware protection key that is supplied with the program into the parallel port connector of your PC.
The hardware key should be plugged directly into the PC, before any other device, to avoid hardware conflict
with other keys.

The printer cable can then be connected to the hardware protection key, as it does not interfere with the printing
operation. If the hardware key has not been correctly installed, the program will start in demo mode.

For further information about the hardware key, please visit the Web site http://www.eutron.com

Windows 95, Windows 98 and Windows Me
Windows 95, Windows 98 and Windows Me automatically recognize the hardware key, so no other operation is
required.

Windows NT, Windows 2000 and Windows XP
Windows NT, Windows 2000 and Windows XP require the installation of a software driver to enable access to
the hardware key. To install the software driver, follow this procedure:

1. start Windows, and login as Administrator
2. install the package

3. browse the program directory, and run the program SKEYADD.EXE in the folder
HardKeyDrivers\Parallel_NT-2000-XP

4. restart the computer
To uninstall the software driver, follow this procedure:
1. start Windows, and login as Administrator

2. browse the program directory, and run the program SKEYRM.EXE in the folder
HardKeyDrivers\Parallel_NT-2000-XP

3. restart the computer

Hardware protection key - USB port

Plug the hardware protection key, supplied with the program, into one of the USB connectors of your PC.

For further information about the hardware key, please visit the Web site http://www.eutron.com

Windows 95, Windows 98, Windows Me, Windows 2000 and Windows XP
All Windows versions, except Windows NT, automatically recognize the PnP hardware key, and require the path
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to load the driver from. To install the driver, follow this procedure:
1. start Windows, and login as Administrator (if necessary)
2. install the package
3. browse the program directory, and select the folder HardKeyDrivers\ USB_9x-Me-2000-XP

Windows NT

Windows NT requires the installation of a software driver to enable the access to the hardware key. To install
the software driver, follow this procedure:

1. start Windows, and login as Administrator
2. install the package

3. browse the program directory, and run the program SKEYUSBADD.EXE in the folder
HardKeyDrivers\USB_NT4

4. restart the computer
To uninstall the software driver, follow this procedure:
1. start Windows, and login as Administrator

2. browse the program directory, and run the program SKEYUSBRM.EXE in the folder
HardKeyDrivers\USB_NT4

3. restart the computer
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Chapter 4 - Using the program in a
local network

Using the program in a local network

The programs can be used in a local network without moving the hardware key from one computer to another.
It is also possible to purchase multiple licenses to use the program on several computers at once.

The computer to which the hardware key is physically connected is defined as the “Server”, and the computer
that requests the authorisation to run in fully operational mode from to the Server is defined as the “Client”.
The program must be installed on the Server (with the proper hardware key drivers if necessary), and on each

Client (in demo mode).
The program keyserver.exe should also be installed on the Server. The installation file of this program can be

found on the distribution CD-ROM, or on the Internet, at the URL:
http://www.geoandsoft.com/download/KeyServerSetup.exe

Run keyserver.exe and the hardware key management window appears.

w, keyserver | | =]

I Local Host IP: 195.89.152.1 Create Program Configuration Files |

Click the “Create Program Configuration File” button, and browse your network to select the executable file you
want to remotely activate (for example \\computerO3\c\program files\happie32\happie32.exe). Now, with the
keyserver.exe program running, happie32.exe can also be run from the PC “computer03”.

NOTE: the contemporary use of the program on more then one computer is allowed only if a multiple
license has been purchased.
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Chapter 5 - General information

Usage Notations

Some typographical notations and keyboard formats are used in this manual to help locate and interpret
information more easily.

Bold print is used to indicate command names and related options. Characters appearing in bold print should
be typed exactly as printed, including spaces.

Words written in italics indicate a request for information.
CAPITAL letters are used to indicate computer, printer, directory, and file names.

Keyboard formats are used as follows:

e KEY1+KEY2 - indicates press and hold down key1 and then, at the same time, press key2. For example,
alt+c means one should press and hold the alt key down and, at the same time, press the c key. The keys
are always indicated with capital letters.

o key1,key2 - A comma (,) between key names means that the keys must be pressed in sequence. For
example, ALT,C means one should press and release the ALT key and then press and release the C key.

Because of the differences in keyboard layouts, the names of the keys on the keyboard may not correspond
with those described in this manual. The word ARROW (LEFT, UP, RIGHT, DOWN) indicates the use of the arrow
keys.
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Chapter 6 - User Interface

User Interface and Data Entering

The user interface is designed to be easy to use and powerful and is supported by complete on-line help. This
help contains practical hints and the theoretical background, where applicable. It should reduce the requirement
of frequently consulting the printed manuals.

All the commands are located inside a menu bar. Each menu contains a list of commands that one can select
with the mouse or the keyboard. The arrangement of the menus, designed with ergonomic criteria, follows the
logical order of the operations, inhibiting the access to further operations until all the necessary data have been
entered.

The interface layout is maintained in all of our programs, to simplify, as much as possible, the transition from
one program to another to avoid having to learn different commands and procedures for similar functions (such
as entering data or managing files).

Let us examine the general components that are available in the user interface of geo&soft programs.

User Interface: Menu Bar and Menus

The Menu Bar manages the access to all the program commands. The goal of the menu design is to offer an
ergonomic, simple, and understandable arrangement of the commands.

The menus used to perform a complete operation are normally ordered left to right and top to bottom. When
possible, the following scheme is used: definition of the name of the project, entering the required data,
performing the calculation, and generating the output as a preview or final print.

[B]HAPPIE !Ii.l

| Files Edt Fiint Est Help

| New  [EES P REAE I@
Open =
Save
Printer Setup

Help

The programs automatically disable some menus or commands when the execution of such menus or
commands is not yet feasible. Typical examples are: a calculation menu is disabled when not all the data
needed for the calculation have been completely entered, or a print menu is disabled if not all the calculations
have been executed.

To choose a command from a menu, use the following procedures:

B Point the menu that is to be activated, click the left button of the mouse, then point the command to be
activated, and click the left button of the mouse again. If one does not wish to select any command
from the menu that is open, exit the area of the menu before releasing the mouse button.

Press the ALT key to activate the menu bar. Press, on the keyboard, the underlined character in the
menu name or press ENTER or the DOWN arrow, to select the first menu. Press on the keyboard the
underlined character in the menu name or select it using the arrow key and then press ENTER, to
execute a command in the selected menu. Press ESC to close the menus without executing any
command.

The Graphical Output Preview Window

The Toolbar is located in the upper side of the preview window.
The Toolbar allows fast access to the commands with the mouse. Click the corresponding icon, to select one of
the commands that belong to the Toolbar. The Toolbar displays the following commands:
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Zoom + : clicking the first icon activates the ZOOM function (it can only be used with the mouse) that
permits the enlargement of part of the drawing. The function remains active until the Zoom - icon is selected.
To enlarge a part of the drawing:

click the icon, and then select the area to be enlarged by clicking the upper-left corner and dragging
the mouse pointer to the lower-right corner. At this point, release the mouse button. Note: due to the
low resolution of the screen, the texts could appear in a slightly different scale at different zoom levels.
This does not affect the quality of the final printouts.

Zoom - : click this icon to return to the original scale of the preview.
Arrows: click the arrow icons, in "Zoom + " mode, to pan the on-screen preview.
Print: click the print icon to send the drawing to the default printer.

Resized print: click this icon to send the drawing to the default printer. The image will be resized to fit the
current paper size.

DXF: one can export the graphic output as a DXF file by clicking this icon; it gives access to a dialogue
window that enables one to assign a different name to the DXF file, which has, by default, the same name
as the current project.

EMF/W: This icon allows the graphic output to be exported to a version of the Enhanced Windows Metafile
which is compatible with Microsoft Word. Clicking this icon gives access to a dialogue window that enables
one to assign a different name to the EMF file, which has, by default, the same name as the current project.

EMF/D: This icon allows the graphic output to be exported to a version of the Enhanced Windows Metafile
which is compatible with Corel Draw. Clicking this icon gives access to a dialogue window that enables one
to assign a different name to the EMF file, which has, by default, the same name as the current project.

Exit: click this icon to close the preview window and return to the main menu.

The Input Dialogue Windows

The different menu commands can perform an immediate action, or display a dialogue window in order to input
or edit the various data sets.

When a dialogue window is visible, all the actions that do not pertain to it are ignored. Hence, it is necessary to
close the dialogue window to resume the normal use of the program.

Sie descrption

Discharge type ... D arcyan or comparable; Medium risk

Lithalogy ..o I Large store gravel lI
Piezametric depbh [Mm] e 0

Hydraulic arade (] . ]

Precipitation [Tm] ... ]

Thicknesz of the superficial media [m] ..o ]

Average EmMPETAtIE [T e ]

Flaw direction [JIN=0E=80] ... e ]

ok | Cancel | Help |

The type of dizcharge, with referal to the type of stratification and to the objective dangerouzness of the
depozited matenal, iz zelected in this field.

Some fundamental tools are used inside the dialogue windows: data fields such as text and list boxes, and
buttons.

The text boxes are used to input numerical values and text strings. Most of the editing keys (HOME, END, INS,
DEL, etc.) can be used inside these fields. If one sees a small arrow pointing down on the right side of the data
field, one has a list box.

To scroll the list box and select an item, do as follows:
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‘B click the arrow, and then click the item to be selected.

press the DOWN arrow until one arrives at the item to be selected. It is also possible to press a letter to
directly reach the first item that begins with that letter.
Tere are three buttons in the dialogue window:

e <QOk> - this button saves the entered information and goes on to the next phase.

e <Cancel> - this button closes the Dialogue window without saving the just entered data, or without
executing the command.

e <Help> - this opens a window that contains general information on how to use the dialogue windows.

To use the buttons:
B click the button

press alt+underlined letter
To edit the data inside the dialogue window, use the following keys:

e TAB - moves the cursor to the next field; when the cursor is inside the last visible field the cursor goes to the
first control button of the Dialogue window. To return to the previous field, press SHIFT+TAB.

e ENTER - moves the cursor to the next field. If the cursor is positioned on one of the window buttons, the
corresponding command is executed.

e BACKSPACE - cancels the last character that has been entered.
e DEL - cancels the character to the right of the cursor.

e ESC - closes the Dialogue window without saving the entered values or without executing the command. The
<Cancel> button will do the same.

e UP ARROW/ DOWN ARROW - these are used in multiple fields, or those fields that have a list box.
e LEFT ARROW/ RIGHT ARROW - moves the cursor to the previous or next field.
e HOME -moves the cursor to the beginning of the field.

e END - moves the cursor to the end of the field.

A yellow box with a short text that explains the meaning of the value to be entered, can be seen in the lower part
of the window. If the text is not completely visible, click the yellow box to read the complete text.

Data Input With Tables

Tables are used to enter long sequences of numerical values and/or text strings. The keys to be used are the
following:

e TAB - moves the cursor to the first button in the window. When one presses this key again, the cursor is
moved to the next button.

e SHIFT+TAB - moves the cursor to the previous button.

e ENTER - moves the cursor into the next input field. If the cursor is positioned on one of the window buttons,
the corresponding command is executed.

e PAGE UP - moves the cursor up 15 lines.

e PAGE DOWN - moves the cursor forward 15 lines.

e UP ARROW - moves the cursor to the input field directly above.

e DOWN ARROW - moves the cursor to the input field directly below.

e LEFT ARROW / RIGHT ARROW - moves the cursor to the field respectively to the left or to the right of the current
position.

e HOME - moves the cursor to the beginning of the line.
e END - moves the cursor to the end of the line.

e F2 - copies the field contents to the extended editing field under the title bar in order to facilitate the editing
of the long strings. When working in this editing field, please REMEMBER to press ENTER, even before
clicking the <Ok> button. Double-clicking a field has the same effect as pressing the F2 key.
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Editing of the well coordinates |

YWell| =-coordinate [u:m]l '-coordinate [u:m]| I ame ‘I

15 j

Defined i thiz columi are the #-coordinates, exprezsed in
centimeters measzured on the original map, of the points of water
that pollution rigks are to be defined for.

ok | Cancel | Irizert | Delete | Help |

The tables have two additional buttons:

e <Insert> - creates an empty line before the one in which the cursor is positioned.

o <Delete> - deletes the line in which the cursor is positioned.

IMPORTANT SUGGESTION: you can copy data to or from other programs such as Microsoft Excel:
The data entered in the table can be copied in order to be pasted into another table.

To copy the table’s contents:

press the key combination CTRL+C. The contents will be copied into the Clipboard of Windows.
To paste the Clipboard contents into the table:

press the key combination SHIFT+INS, or CTRL+V.
A yellow box with a short text that explains the meaning of the value to be entered, can be seen in the lower part
of the window. If the text is not completely visible, click the yellow box to read the complete text.

Message Windows

The function of these windows is to give information to the user concerning the system status, as in the case of
an error due to an improper use of the program.

WARNING!

[t iz not pozzible to edit data before having opened a file.

Help On Line

A complete Help On Line is available. It is possible to ask for information or suggestions related to the
commands or the use of the program. In order to access the help on line, proceed as follows:

1. Position the cursor on a field of a dialogue window and press F1.

2. Use the Summary from the Help menu.
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Chapter 7 - Commands

Files Menu (ALT,F)

This menu contains the commands for opening and saving files. In these all the information relative to the
project is stored. Until a name is given to the work the program will not permit the use of other menus.

[G]HAPPIE !IEI
| Files Edit Fiint Ext Help
| New |3 =TT Ab| | & | & | 5 I@
Qpen =
Save
Frinter Setup
Help

New Command (ALT,F,N)
To open a new file:

B from the menu choose New by first clicking on the name of the menu then on the New command.

from the File menu choose New by using the combination of the keys ALT,F,N.

Open Command (ALT,F,0)

To be able to work with the program one should, first of all, create a new file or open a pre-existing file.
To open a file:

B from the menu choose Open by first clicking on the name of the menu then on the Open command. In
the File Name field type the name of the file to be opened or, if the file already exists, double click on
the name of the desired document which can be found in the list underneath the File Name field.

from the File menu choose Open by using the combination of the keys ALT,F,0. In the File Name cell,
type the name of the file to be opened or, if the file already exists, press TAB and then the UP ARROW or
DOWN ARROW to select the name from the list underneath the File Name field and press ENTER.

The name of the file being used is reported inside the title bar of the main window and inside a window referable

by selecting the Help menu.

The name of the file should not contain spaces and/or punctuation marks. It is not necessary to indicate

extensions, since the extension “.HAP” is added automatically: for example, the given name “TEST” will have

the file name “TEST1.HAP"

Save Command (ALT,F,S)

During the work session the program uses a copy of the file which is temporarily loaded into the computer’s
RAM. To save work on the hard disk it is necessary to use the Save command; otherwise all the data introduced
will be lost when one exits from the program. If an electrical problem or any other type of problem interrupts the
computer’s functioning all the data not yet saved will be lost, so it is advisable to save the work often.

To save a file:

B select Save from the file menu by clicking first on the name of the menu and then on the Save
command. In the File Name field, the name given to the file when it was originally opened appears. To
confirm that name click on the <Ok> button. To assign a new name to the file, type the new name in
this field.
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select Save from the File menu by using the key combination ALT,F,S. To confirm the name given to the
file when it was opened press ENTER. To assign a new name, type the name in the File Name field and press
ENTER.

The program will save the file in the current disk unit and directory unless specified otherwise. To save the file
on a different disk unit or in a different directory, type the full path in the File Name field. For example, to save
the document in the root of disk C: type c:\filename or select a different unit or directory.

Printer Setup Command (ALT,F,C)

By selecting this command one goes to “Print” dialog box. Here one can verify and modify the Default printer’s
Setup or select another printer from those installed one ones system.
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Edit Menu (ALT,E)

Introduced through this menu is the input data necessary to the program for determining security zone.

HAPPIE [l B |

Files | Edit Print Ezit Help
gD | Dizcharge geometmy EI;] ‘@,
i 2 Geological Description % %
Wiell Description
Titles
Help

Discharge Geometry Command (ALT,E,D)
This is used to enter the geometric parameters extracted from the original map.

The "Discharge geometry" Dialog Box
In the “Discharge geometry” dialogue box the following must be entered:

Dizcharge geometry

Original map scale 1 e, |
blap width [2m] ..o
fap height [om] .o
Digcharge #-coordinate [om] ...
Digcharge Y-coordinate [om] ...

ok Cancel Help

The data relative to the positioning of the dizcharge and the paintz of water must be introduced in
centimeters meazured directly on the onginal map, the zcale of which iz ingerted here.

— Original map scale: this is the scale factor denominator of the map from which the positions of the discharge
and water wells are taken.

— Length and height of the original map: these must be expressed in centimetres. For simplicity, no reference
was made to coordinate systems related to the ellipsoid, but a Cartesian system was used instead, with the
origin located in the lower left corner of the map used, and the Y axis directed North with coordinates
measured in centimetres.

— Abscissa and ordinate of the discharge: the coordinates must be expressed in centimetres with respect to
the origin, located in the lower left of the map.
To confirm click on the <Ok> button.

Geological Description Command (ALT,E,G)
With this command it is possible to define the geologic parameters that characterise the discharge site.

The "Site description” Dialog Box

The following parameters are required:



16 - H.A.P.P.1.E. for Windows - User Guide

Site dezcnption |

Dizcharge type D arcyan or comparable; bMedium rigk
Lithalogy .o

Fiezometric depth [M] oo i
Hudraulic arade [%] ..ot 0]
Precipitation [ ... e seer et eer s sr e sre s 0]
Thicknesz of the superficial media [m] ..o 0]
Brerage EMPEratug [T .. 0]
Flows direction [*TIN=0E=30] ... 0]

ok | Cancel | Help |

The type of dizcharge, with referal to the type af stratification and to the objective dangerousness of the
depozited material, iz zelected in thiz field.

— Discharge type: The lithology and the type of materials positioned at the discharge must be considered
when making a choice; there are three types of discharges to choose from:

obeying Darcy’s law or comparable; Medium risk
obeying Darcy’s law at top, not obeying Darcy’s law at a slight depth; discharge at medium risk
comparable to flow obeying Darcy’s law; High risk

The field displays an arrow pointing down, with this it is possible to see the option list foreseen by the
program: click on this icon and select the type one wishes by clicking on it.

— Lithology: defined in this field is the type of lithology of the porous media underneath the discharge. The
following are the lithotypes to choose from: Coarse gravel, Gravel and sand, Coarse grained sand, Fine
sand, Silty sand, Silt, Sand and clay, Sandy clay, Clay, Fissured rock, Rock w. Karst phenomena.

The field displays an arrow pointing down, with this it is possible to see the lithology list foreseen by the
program: click on this icon and select the lithology clicking on it. From a geohydrologic point of view the
most significant lithotype must be considered: for example, a terrain formed of gravel with sandy matrix will
probably have the geohydrologic behaviour of sand only.

— Piezometric depth: the more cautious minimum value must be considered; it is expressed in meters from the
ground level plane.

— Hydraulic grade: this parameter is somewhat difficult to evaluate since it requires the knowledge of at least
three points of the water table surface or, indirectly, of the flow velocity and of the medium’s permeability. It
must be expressed as a percentage.

— Precipitation: it is prudent to refer to the annual values taken in years of more intense precipitation. It must
be expressed in millimetres per year.

— Thickness of the superficial media: thickness of the permeable layer above an impermeable bed at a
shallow depth. The given value is used only for the type of discharge that uses this information. It is
expressed in meters.

— Average temperature: Average annual temperature, expressed in degreees centigrade, it is used by the
program to calculate the effective rainfall.

— Flow direction (Degrees N=0 E=90): this parameter is also difficult to survey, needing a certain number of in
situ measures. It is expressed in degrees, clockwise from North, this value is ignored if the discharge is at
high risk.

To confirm click on the <Ok> button.

Well Description Command (ALT,E,W)

With this command one enters the coordinates of the water wells taken from the original map. The program
uses these values to assign a risk level to them.
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The "Editing of the well coordinates” Dialog Box
The data required are:

Editing of the well coordinates

YWell| =-coordinate [u:m]l '-coordinate [u:m]| I ame Al

15 ﬂ

Defined i thiz columi are the #-coordinates, exprezsed in
centimeters measzured on the original map, of the points of water
that pollution rigks are to be defined for.

ok | Cancel | Irizert | Delete | Help |

— Abscissa and ordinate of the well: these must be defined in centimetres and measured directly on the
original map with respect to the lower left corner of the map.

— Well nhame: allows a name, that will be shown on the map, to be associated to each well.

Titles Command (ALT,E,T)

The program allows one to enter of up to four lines of text to be used as a title on the map. A slightly larger
character size will be used for the main title.

Pairbitle . |
Subtitle T
Subtitle 2
Subtitle 3.
Final output scale 1:

ok Cancel Help

The main title will be reparted with a slightly larger character than the fallowing three.

The scale to be used when creating a drawing can be defined by the user.
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Print Menu (ALT,P)

With this menu it is possible to produce output in the form of graphics or tables after having selected the data to
be represented directly from these menu voices.

[@]HAPPIE [l B |
Files Edit| Print Ext Help

ﬁ E Graphics i-l—rl-r: Ab %

== Liztings  ®
LConfigure
Help

|l
(]

Graphics Command (ALT,P,G)

By selecting this command, the program carries out calculations if they haven’t already been executed; when
terminated, the graphic is designed reporting the obtained results. ow and the program returns.

Listings Command (ALT,P,L)
By selecting this command the program opens a sub-menu where one can select the preview mode, and wether
to print or export the listing.

Listings Preview Command (ALT,P,L,P)

With this command it is possible to preview the listings pertaining to the calculation result. The listing can not be
changed here.

To scroll the text use the scroll bars on the window or use the UP and DOWN arrow keys, or the PAGE UP e PAGE
DOWN. keys. To exit press ESC or double-click any point of the listing.

The file containing the listing is saved on disc in the same directory where the data files resides. It has the same
name with the difference of the ".TAB" extension. The file is in the normal ASCII format and its pagination is
such that all commands have the # sign as prefix.

Fast Print Listings Command (ALT,P,L,F)
With this command the listings pertaining to the calculation result are printed directly.

Export Listings in DOC Format (ALT,P,L,E)

With this command the listings pertaining to the calculation result are exported in the format used by Microsoft
Word 97.

The file will have the same name but with the ".DOC" extension and will be saved in the same directory where
the data files reside.

The file is automatically opened if the program finds the Microsoft Word executable.

Export Listings in TXT format (ALT,P,L,E)

With this command the listings pertaining to the calculation result are exported in the “Text only” format.

The file will have the same name but with the ".TXT extension and will be saved in the same directory where the
data files reside.

The file is automatically opened if the program finds the Microsoft Note Pad executable.

Listing Export to SLK (ALT,P,L,S)

With this command, it is possible to export the listings of the calculation results into the SLK format (Microsoft
Excel 97 compatible).

The program creates a file, with the same name as the current project but with the ".SLK" extension; the file is
saved in the same directory as the data files.

The file is automatically opened if the program finds the Microsoft Excel executable.
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Configure Command (ALT,P,C)
With this command, one can define the graphical properties of the different objects in the graphical output.

COLOUR SELECTION

T IIIIIIEIIIIIII=, e Colours

Hi Sne: H

points ) Not drawn
caphions

dizcharge

firzt lesvel of risk
zecond level of nisk
third level of righ,
fourth lesel of rigk,
fifth leseel of risk
sixth level of rigk .
rnair title ) light gra
subtitle

_ light green
(_ light cyan

Arial Black
Anal Marraws

AvantiG arde 1| O yellow

i) black

Thickness (mm)

Left D Taop ||:| | ak. Cancel

|rrv1argins ferm)

One can associate a colour, a line thickness and a character font to each object. Notice that not all the objects
have both a line thickness and a character font: for example, a fitle only requires the colour and the character
font to be defined.

e Click an object to select it (use the scroll bar to see the entire list)

e Click one of the option buttons, in the “colours” frame, to select the colour that has to be associated to the
selected object. The Not drawn option hides the object of the graphical output.

o If the object contains texts, one can choose a character font from the list (use the scroll bar to see the entire
list)

e |f the object contains lines, one can assign a thickness to the lines (in mm). If the value is zero, the program
uses the thinnest line on the output device.

It is possible, as an option, to assign a left and a top margin (in cm) to the whole graphical output.

NOTE: although the available set is limited to fifteen colours, they can be manually customised; double-click the
coloured bar to open the Colour Dialogue Box and choose a different RGB value associated to the selected
colour.
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Exit Menu (ALT,X)

This command allows one to exit the program. If the file in use contains data that have not yet been saved, the
program will present the window used to save files, as described previously.
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Chapter 8 - An annotated example

An annotated example

In this chapter we present a simple example that we suggest that one works through as to familiarise oneself
with the program.

Remember that the only parts to type, be it commands or input data, are those written in boldface while the
single keys are written in SMALL CAPITALS.

1. Start the program by double-clicking on the HAPPIE icon. To close the message window click on the <Ok>
button or press ENTER or the SPACE BAR.

2. One is now inside the program. Click on the File menu hence click on the Open command.

Start the program by double-clicking on the HAPPIE icon. To close the message window click on the <Ok>
button or press ENTER or the SPACE BAR.

4. One is now inside the program. Click on the File menu hence click on the Open command.
Enter test in the File Name field and click on the <Ok> button to confirm.

Now go on to fill out the parameters form. Activate the Edit menu and select the discharge geometry
command by clicking on it. Information relative to the original map geometry and to the position of the
discharge is required. Enter the following values:

5000 TAB
50 TAB
50 TAB
25 TAB
25 TAB

In this way the discharge is positioned exactly in centre of the map; the coordinates are in centimetres with
respect to the origin, located in the lower left corner of the map.

7. Open the Edit menu again and select the Geological description command. On the right of some fields there
is an arrow facing downward: by clicking on this arrow one can scroll the list of available options. Leave the
type of discharge proposed and press TAB to pass on to the next field. Now define the lithology of the porous
medium: click on the arrow present in the field and select Large Grained Sand by clicking on this line. From
a geohydrologic point of view, the most significant lithotype must be considered when making a choice: for
example, a terrain formed of gravel with sandy matrix will probably have the geohydrologic behaviour of
sand only. Now enter the rest of the data:

3 1AB

5 TAB

1200 TAB

0 TAB

12 TAB

45 TAB

To confirm click on the <Ok> button.

8. Then pass on to the enter the well coordinates. After having once more selected the Edit menu select up the
Well Description command. Now enter the data relative to four wells:

12 TAB
10 TAB
P1 TAB
30 TAB
40 TAB
P2 TAB



10.

11

12.
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8 1AB
36 TAB
VILLA TAB
30 TAB
20 TAB
FARM TAB
To confirm click on the <Ok> button.

Before executing the calculation of the data entered, open the Edit menu and select the Titles command.
Type the following titles:

HAPPIE PROGRAM TAB
HAZARD MAP TAB
FILE: TEST TAB

SCALE 1:10000 TAB
10000 TAB

As one can see, the titles, that exceed the field’s length, are scrolled; it is possible to modify or correct them
by scrolling the cursor with the ARROW keys. To confirm click on the <OK> button.

Thus we have finished entering data and can pass on to the calculation. Open the Print menu by clicking on
it:
- Graphic: allows the visualisation or printing of the graphical output.

- Listings: under thus command one finds the sub-menus that allow one to visualise, print and export the
result listings.

- Configure: permits one to define the colour configurations, the thickness and character set to be used
when printing the graphics.

. Select the the Graphics command. After calculations have been executed, the duration of which depends on

the type of computer used, the elaborated graphic that reports the calculation results is designed. With the
instrument bar you can carry out the following operations:

- Zoom +: enlarges a part of a page. Note: if one does not have a character font suited for the visualisation
of the selected dimension, the program will substitute it with another.

- Zoom -: returns the drawing to the original dimension.

- Arrows: clicking on the arrow icons after having activated "Zoom +" one can pan the drawing visible on
screen.

- Print: clicking on this third icon, or pressing the letter p key, will send the drawing to the default printer.
When the printing has finished the program returns to menu.

- Resized print: by clicking on the command the drawing is printed on the default printer resized in such a
way as to be drawn on a single page.

- DXF: clicking on this command gives access to a dialog box that enables one to assign a different name to
the DXF file, which has by default, the same name as the data file.

- Exit: closes the window and returns to the program.

To terminate the work session select the Exit menu: the file being used contains modifications that have not
yet been saved and so the program will ask if you desire to save these by proposing the “Save as” dialog
box. To save the file click on the <OK> button.
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